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Reviewer to tell about new programs
Terry Currier reviews products and programs each month for the newsletter and

monthly programs of WINNERS, a Windows’ users
computer group in Costa Mesa. Terry is their Vice
President, Webmaster, Program Chair, and APCUG Rep.

For the ORCOPUG May 11 meeting, Terry will be
showing some of the programs he has reviewed or is in the
process of reviewing. His product reviews include the
Kyocera digital camera, Executive Diskkeeper defragger,
Altec Lansing speakers, Vox Proxy (a PowerPoint add-in),
and the Planon scanner.

Terry Currier retired in January as a computer operator
for Ford Motor Co. where he helped to maintain computers,

terminals, laser printers, inkjets, thermal printers, and a mainframe. He also held
several classes for employees at a Ford Special Education Center on what to
look for in buying a computer and to how to maintain it.

In addition, three of his articles
were published on the web. Two were
on mediaandbeyond.com, and a
review about the Belkin UPS unit
currently appears on TechTV.com.

Fun In the Sun and
Computers, Too!

Patricia Hill and Judy Taylour
Co-chairs, SW User Group
Conference

Web Site Contest! Door Prize
Drawings! Networking! T-shirts and
Welcome Kits! All this and more can
be found at the 11th Annual Southwest
User Group (SWUG) Conference.

This year’s activities run from
Friday evening, August 6 through
Sunday, August 8 at the Mission Valley
Hilton in San Diego. Planned activities
include workshops, vendor-sponsored
presentations and meals, a Saturday
evening Vendor Faire, numerous prize
drawings as well personal contact with
participating vendors.

“The leadership of the conference
always finds good vendors who make
excellent presentations about their
software. In many cases these
vendors will give each attendee a copy
of their software to take home and
learn,” said Ed Zarr, Sunland Village
East Computer Club.

(Continued to page 7)

APCUG Fall Conference
scheduled

by Ed Van Meter, Region 11 Advisor

Mark your calendars! The APCUG
2004 Fall Conference is scheduled for
Friday, November 12 through Tuesday,
November 16, at the Stardust Hotel &
Conference Center, Las Vegas. New
this year: Conference is open to all
User Group members, Round Tables
start Friday afternoon, Spouse program,
and Repeating Round Table sessions.

Information will soon be sent about
Registration dates—don’t miss the
“early bird” pricing.

Terry Currier
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Notepad
Healthy PC author helps member

I have been having a variety of
problems with my computer since I
followed the instructions in Carey
Holzman's book, “The Healthy PC.” I
compounded my problems by changing
ISPs at the same time. Lesson-change
one thing at a time. My problems
were: 1) I could not download pdf files
from the web and that includes the
ORCOPUG newsletter, 2) my dial up
connection speed dropped from
49 kb/s to 31 kb/s, and 3) I would get
messages that something could not
download because security would not
allow the use of Active X.

After thinking my ISP was at fault
for the pdf file problem based on
various messages that I got, I had
quite a series of messages with their
tech service who finally said, correctly,
that it was a system problem, not
theirs. In desperation I sent a message
to Carey and received an answer one
hour and twenty minutes later—how
about that for a good response! He
suggested restoring the default settings
(Control Panel–Internet Properties–
Security and set default on each of the
four icons). That restored the pdf
downloading problem. For the Active
X, follow the same path but go to
Advanced rather than Security and
again restore defaults.

Not only did this seem to cure the
pdf and Active X problems, it restored
my connection speed. I have verified
that the ISP was not responsible for
any of the problems since changing the
ISP was the only change in the
computer and everything worked on
the machine.

Richard Tooley
tooley@alum.mit.edu

Looking for Amazon reviewers

Would you or your members be
interested in writing reviews for
Amazon? O’Reilly is always looking
for avid readers who can help us out

by posting their thoughts. You can keep
the books you review! Please pass this
info along to folks who might be
interested. And if you don’t already,
please consider posting copies of your
current UG reviews on Amazon, as
well as your group’s site or email list.
Let me know if you need more info!

Marsee Henon
marsee@oreilly.com

Small but free

TinyApps.org, is a guide to very
small software programs and provides
program downloads (most are free) at
http://www.tinyapps.org/.

Submitted by Tony Lake

This month, there are several
important computer issues.

One is the W32.Sasser worm.
It doesn’t do any direct damage.
But, the worm uses a massive
amount of your computer’s re-
sources so it slows down or even
seems to stop completely.If you
have not downloaded and installed
the latest Windows update to cover
this vulnerability, please do it now.

Here’s the link for the Microsoft
page that gives you details about
sasser and contains an online
checking program to see if your
computer is already infected by it.
http://www.microsoft .com/security/
incident/sasser.asp.

This dovetails with another piece
of information I want to pass along.
Advice has been given that you
need to enable Windows XP’s built-
in Internet Connection Firewall
(ICF) to help protect your computer
from worms like sasser—even if
you are behind a router. This is a
misconception.

The ICF works for local area
network (LAN) or dial–up connec-
tions but only provides protection
for computers DIRECTLY con-
nected to the Internet. If you have a
dial-up, DSL, or cable modem
without a router, the ICF should be
used. Here is a link showing how to
enable it: http://www.practically
networked.com/sharing/xp/
ic_firewall.htm.

Another issue concerns AOL’s
blocking policy. Did you know that
AOL reads the INSIDE of ALL
incoming emails? It does this to
block any messages that contain
links to sites that AOL doesn’t want
you to see!

This is not just a simple mail
block where a message is dis-
carded if it originates from a
“forbidden” address. But, in fact, by
scanning the content of email going
to subscribers, it blocks them from
being delivered to the AOL sub-
scriber even if the email merely
mentions the name of a site that

(Continued to page 10)
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� �New Member Renewal*

Last Name First Name

Mailing Address

City State Zip

Home Phone ( ) Work Phone ( )

E-mail Address

Areas of Interest/Comments

(Please fiill out this application and mail it today!)

Membership Application

ORCOPUG meets the second Tuesday of every month starting at 6:30 p.m. Dues
are $25 per year. Please see our website at www.orcopug.org for meeting location
and map, program announcements and contact information.

Make check payable to ORCOPUG
Mail to ORCOPUG, P.O. BOX 716, Brea, California 92822-0716

Balazs, Frank
fbalazs@netzero.net

Bazerman, Siles
siles.bazerman@gte.net

Boutwell, Lloyd
LloydB8@aol.com

Bullis, Art
bullis@worldnet.att.net

Brubaker, Jim
info@1homeseller.com

Covington III, Gary
garyiii@hotmail.com

Emigh, Glenn
glenne@linkline.com

Francis, Joe
joefran1@earthlink.net

Frank, Mervin
mfrank3@juno.com

Gonse, Linda
editor@orcopug.org

Gorham, Milton
m4gorham@home.com

Graham, Sharon
shgraham@earthlink.net

Jackson, Walter
wvjaxn@charter.net

Kaump, LeRoy
leroy_kaump@hotmail.com

Klees, Larry
lklees@dslextreme.com

Lake, Tony
TonyLake@juno.com

Leese, Stan
stan_leese@surfside.net

Loehr, Lothar
lothar@orcopug.org

Lyons, Mike
mike@orcopug.org

Moore, Charlie
charlie@orcopug.org

Musser, Dave
dmusser@worldnet.att.net

Schiele, Terry
terry@orcopug.org

Tooley, Richard D.
tooley@alum.mit.edu

Wann, Harold
WANN.HSW@worldnet.att.net

Westberg, Carl
carl@orcopug.org

Wirtz, Ted
twirtz@pacbell.net

�

* Please fill out all the blanks below to help us keep
your information updated in our database.

Include your listing so other
members can reach you. Send your
information to: editor@orcopug.org.

Got a new address or ISP?

Don’t miss newsletters or announce-
ments! Send your new information to
Charlie Moore, Treasurer/Membership
Chairman, charlie@orcopug.org.

Members’ renewal dates

MARCH  — Jim Brubaker, Sharon
Graham
APRIL  — David Musser
MAY  — Terry Schiele, Harold Wann
JUNE  — R.A. Metzger, Terry Terrazas
JULY  — Herman Beverburg, Joe
Francis, Walter Jackson, Tony Lake,
Ralph Seymour
AUGUST  — Stan Leese, Sid Liptz,
Michael Moore

Submitted by Charlie Moore

Members’ email March raffle winners

U-Lead Photo Explorer,  $39*
John Bednarski, Expired
Charlie Moore, Winner

U-Lead PhotoImpact XL,  $79*
Sharon Graham, Expired
Bud Barkhurst, Not Present
Stan Leese, Winner

Smart Computing magazine
subscription,  $25*
Michael Moore, Not Present
Harold Wann, Winner

Smart Computing 2003 issues, $25*
Ted Wirtz, Winner

U-Lead PhotoVideoStudio,  $79*
Joe Gionet, Winner

U-Lead PhotoExplorer,  $39*
Larry Klees, Winner

South Bay Engineering fan,  $25*
Siles Bazerman, Not Present
Sharon Graham, Expired

Lind Gonse, Not Present
Carl Westberg, Winner

*Estimated value

Submitted by Charlie Moore

Don’t be the victim of a virus or hoax! Check the TOP 10 hoaxes & viruses at
www.orcopug.org

Write reviews online!
Fill in an online review form and click
to submit your reviews. Go to www.
orcopug.org, Review, and Online
Review Form. It’s fast and easy!
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How to…                 

Use Run commands for fast access to
almost everything
by Linda Gonse

Did you know that the  Run command  is the Swiss Army knife of Windows’
built-in apps? Using it can make your computing time move along more quickly
and smoothly.

Available since Windows 3.1, the Run command is often overlooked by users
except as an option for installing
programs, although techies use it
frequently to access various
system diagnostics and
information.

But, the average computer
user should take a closer look at
Run for its versatility. For

example: Run can be used for quick access to the Startup Configuration tab, to
start programs and utilities, to open files and folders, to open web sites (when
connected to the Internet), and as an alternative to placing shortcuts on the
desktop.

To use a Run command, click on the Start button. Click on Run. In the open
box, type in one of the following commands—there are others besides those
listed here— and click on OK. Alternately, if you have a Windows key on your
keyboard you can avoid using the mouse by pressing Windows and the letter “r”.

calc (opens calculator utility)
cdplayer (opens cd player)
charmap (opens character map utility)
clipbrd (opens clipboard utility)
command (opens DOS window at command line)
defrag (opens defrag utility)
drvspace (opens drive space utility to compress drives, etc.)
dxdiag (for DirectX, sound, input devices-joysticks, etc. info)
freecell (opens freecell game)
mplayer2 (opens Windows Media Player 6.4)
msconfig (accesses programs that run on startup)
mshearts (opens hearts game)
msinfo32 (accesses system resources info)
notepad (opens program)
regedit (accesses command to edit the registry)
rsrcmtr (loads resource meter utility in system tray)
scandskw (accesses scan disk utility)
scanregw (registry scan)
sndrec32 (opens sound recorder)
sndvol32 (opens sound volume utility)
sol (opens a solitaire game)
sysedit (accesses the System Configuration Utility)
sysmon (opens system monitor utility)

win.ini (accesses file that loads
some Windows components)
winipcfg (displays Internet
connection/adapter info)
winver (displays the Windows
verson installed on the computer)
wmplayer (opens Windows Media
Player)
wordpad (opens program)
wupdmgr (connects to Windows
update)

Using the Run box can also give
you a jump start on addressing your
email messages. Go to Run and type in
mailto:<desired email address> and
press OK.  (Example—mailto:editor
@orcopug.org.) Your e-mail appli-
cation will open to display a blank new
message that already has the email
address you typed in the ‘To:’ field!
You can even check websites by
typing in a web address in Run. (Ex-
ample—http://www. orcopug.org.)
When connected to the Internet, you
will be whisked to wherever you want
to go.

In addition, you can type in DOS
commands in the Run box to accom-
plish tasks, such as attrib, move, or
xcopy. There are many more DOS
commands that you can use in con-
junction with Windows Run.

To see them, go to  http://www.
techiwarehouse.com/DOS/XP_DOS
_Tutorial.html, or http://www.
computerhope.com/msdos.htm#02

As you type commands in the Run
box, a list of your Most Recently Used
(MRU)  commands—a history of the
commands you’ve used—accumulate.
The growing list can come in handy,
because you can just click on any
command to activate it without
retyping it.

On the other hand, you may not
want to wade through  a long list, or
you may not want others to have
access to the visible commands. In
these cases, you need to clear the
MRU commands. Here are two ways
you can do that.

1. Right click the start button and

(Continued to page 10)
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Submitted by Carl Westberg

Revised 7/1/2003

These prices are for new subscriptions and renewals. All orders must be accompa-
nied by a check, cash or Money Order. Make payable to Herb Goodman, and mail
to: Herb Goodman, 8295 Sunlake Drive, Boca Raton, FL 33496. Call or write:
561-488-4465, hgoodman@prodigy.net.

Please allow 10 to 12 weeks for your magazines to start. For renewals you
must supply an address label from your present subscription to insure the correct
start of your renewal.

I will mail a renewal notice to every subscriber about 3 months prior to their
expiration date.Many computer magazine subscribers have used my services for
over 300 titles I carry, also at excellent prices. Just email me for other prices.

1 Year 2 Years 3 Years

Computer Games $10.95
Computer Gaming World $14.95 $28.95 $41.95
Computer Shopper $16.97 $32.95 $47.95
Dr. Dobbs Journal $15.95 $30.95 $43.95
Mac Addict $10.97
Mac Home Journal $15.97 $29.97
Mac World $12.95 $24.95 $35.95
Maximum PC $ 9.95 $18.95 $27.95
Microsoft System Journal $21.95 $39.95 $57.95
PC Gamer $12.95
PC Magazine $25.97 $48.95 $68.95
PC World $16.95 $27.95 $40.95
Wired $ 6.00 $12.00

Magazine discounts just for computer user groups

User group deals

June 6  •  8 a.m. to 2 p.m.
1310 E. Edinger, Santa Ana, CA

714-558-8813 • www.acpsuperstore.com

GIANT Computer Swap Meet

Free Admission
Free Parking

100’s of Sellers

What do you get from a
membership in our  group?

by Linda Gonse

Membership in ORCOPUG entitles you
to access the Members’ Only area on
our website where you are eligible for
user  group offers and discounts worth
hundreds of dollars!

Among other programs currently
offered, are: File Protector, O’Reilly
Books, Drive Image 7, Stuffit 8.0,
AlienSkin pro-grams, Keyfinder, Kroll
ONtrack programs, Aladdin products,
Klassic Specialties, Que Publishing,
Road Wired, Earthlink, Blue Squirrel,
Click2PDF, Flip Album, Diskeeper
Lite, and Hemera PhotoObjects.

How to access Members’ page

Go to http://www. orcopug.org. Click
on the “members’ only” link on the left
side of the page. When the password
dialog box opens,  type your user name
(this is your first initial and last name in
lower case, no spaces), and your
password. The password is a capital
letter “R” followed by your member
number.

User groups represent the spirit of the frontier, a community
getting together to do things that no individual ought to have to do alone.
The pioneers of the American west got together for barn raisings, cattle
roundups, and the occasional party. The pioneers of new technology get
together for installfests, new user training and support, and just plain fun.
Being part of a user group is the best way to get more out of your
computer, and lets you make friends while you're at it. — Tim O'Reilly,
President, O'Reilly & Associates

Please support the companies
below who donated prizes to
our fundraising raffle this year.
Buy their products and tell oth-
ers about them! And, whenever
you can — say “thanks” for
helping us out, won’t you?

Adept, AlienSkin, Belkin,
J.D. Savage, LapLink,

Laser Service, New Riders,
nik multimedia, NotePage,

O’Reilly & Associates,
PKWare, PowerQuest,

RoadWired, Smart
Computing, SmartDraw,
South Bay Engineering,

Stardock, Limit Software,
Ulead, Microsoft

*

mailto:hgoodman@prodigy.net.


Orange County IBM PC Users’ Group
May 20046

Reviews…

AVerDVD EZMaker
by Terry Currier

The AVerDVD EZMaker from
AverMedia is used to capture
movies directly from a video camera,
or VCR through either a composite
video port (RCA jack), or S-Video
plug. You can get sound in from a
sound card. You can also capture
TV output. Perhaps I should tell you
right away I don’t have a DVD
burner. So, why would I be interested in this? Well it works the same way on a
CD-ROM burner. By the way, with video files on a CD they call it a VCD.

They use neoDVDstandard 4.0 software from MedioStream for making the
conversion. The card comes with a one year warranty. Users can capture video
from any analog source and save it to a hard drive, DVD, or VCD with MPEG-
1 or MPEG-2 quality and resolution up to 720x480.

Installing was very easy, put the card in, and it came up right away looking
for the installation files. Hooked up a RCA jack cable to my camera and the
card, and I was ready to go. With the neoDVDstandard software the user can
easily capture the video and do a one step process of burning it directly to a
DVD, or VCD. You can also save it to a hard drive until you’re ready to burn a
disk.

You can create a menu with titles for different chapters. A thumbnail image is
automatically created for each chapter. A chapter being each capture or MPEG
you add. Choose from 15 different background images, along with 11 types of
frames. Their nine step wizard walks you through the choices and gives you a
preview of how it will look. You can add or delete clips onto the same DVD. It
will also let you import DV, AVI, QuickTime, and MPEG files directly into it. So
any of those shows you’ve recorded from your AverTV card you can bring in.
You can also do audio overlays onto a video clip.

Don’t expect to cut or add scenes within a capture though. If you want to
edit parts within a video you will need a more powerful program. It will do
NTSC/PAL conversion.

· Supports all DVD Formats - Write DVD Format to Optical Media:
CD-R, CD-RW, DVD-R, DVD-RW, DVD-RAM, DVD+RW,
DVD+R

· Write VCD Format to HD, CD-R, CD-RW
· Three Quality Video Options (Low, Medium, High)
· CPU: 1 Gig or Higher
· Operating System: Windows 98SE/Me/2000/XP
· AGP Graphic Card with 8MB Memory, and more

How much space will this take? Well I record/captured 8 minutes which
turned out to be a MPEG file at 292Mb. When converted it takes less space.
AverMedia says you can put up to one hour onto a 700Mb VCD (MPEG-1), and
up to 3 hours and 20 minutes onto a DVD (MPEG-2). Just remember, if you do
record first to the hard drive you will need a lot of free space.

You can also copy DVD’s on to another DVD but it will not bypass the copy
protection. This make it easy to convert those old video tapes you have on to a

DVD, and at $50 it is a good buy.
AverMedia (408) 263-3828
www.aver.com

Photo Backup 2.0.6

by Carl Westberg

There is some relatively new
software of value to those using digital
cameras. I found this program on
Tucows, but the version listed there
(2.0.2) was a bit buggy. However
there is an email address to the author
who furnished a later version (2.0.6)
in a couple of days.

If others like me have gotten in the
habit of using a digital camera in order
to have immediate images, you have
the problem of storing them.
Inasmuch as each image can use 3+
Megabytes of space on the storage
media and CF media still costing
something, although not nearly what
they did when I started on digital,
most users will probably move their
images to a hard disk. Now, what
happens when the hard disk eats it. I
have had several do that. Inasmuch as
there are no backup negatives the
files should be backed up. If you
follow any sort of a filing system,
other than chronological, you will have
a problem consistently maintaining the
backups.

PhotoBackup combines a backup
facility, utilizing your CD burning
software, with a data base maintaining
a record of what you have already
backed up. In addition PhotoBackup
can be set to periodically search for
files with specific suffixes, like .jpg or
.tif, for backup. The software creates
thumbnails of the images so that you
are not just left with a file number and
a “what is that?”

Contact info:  Amir Helzer, Support
@onthegosoft.com, Download: http:/
/www.onthegosoft.com/download
.htm, Shareware: $20. Requirements:
Windows 98/Me/2000/XP, 64Mbyte
RAM, 15Mbyte disk space, CD or
DVD burner
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Fun in the Sun…
(Continued from page 1)

There will be newsletter and web
page contests for all user groups with
officers in attendance. All attendees
will receive a t-shirt and Welcome Kit
stuffed with all sorts of promotional
materials, most with special pricing.

User group members will have an
opportunity to interface and network
with user group leaders to share ideas
and experiences, as well as solutions
to problems. This year’s user group
leader and PC skill enhancement
workshops will be even more exciting.

The conference registration fee is
$40 per person if paid by July 16. If
registered and paid between July 17
and 23, the fee is $50; July 24 through
the conference date is $60. The
conference registration fee includes
admittance to all workshops and
Vendor Faire; meals and vendor
presentations; a Welcome Kit and a T-
shirt.

“I especially enjoyed the Vendor
Faire on Saturday night when I had an
opportunity to see close up and hands
on the many products, applications,
and equipment that the company
representatives bought along for
display and sale,”Delvina Fiducia, SIG
leader, Temecula Valley Computer
User Group said.

The conference will be held at the
Mission Valley Hilton, 901 Camino del
Rio South in San Diego. Reserve your
room at a special group rate of $109,
single or double occupancy. To make
your reservations, call the toll-free
reservation number 800-733-2332 by
July 16 and tell them you are attending
the Southwest User Group
Conference.

Stay at the host hotel and you are
automatically entered into a drawing to
receive one of your conference nights
FREE!

For more information contact Judy
Taylour at judy@swugconf.org,
Patricia Hill at swugconf@aol.com,
or visit www.swugconf.org.

Building a computer
by Carl Westberg

This possibly should be titled “How not to build
a computer.”
Having purchased a couple of branded computers

which had a bunch of problems, I decided that if I wanted
a more powerful computer, I should select the components
and build one myself. After all I had built a couple of other
less powerful computers and it should be just a matter of buying more advanced
components. One restriction, since the stock market swooned, I didn’t have the
resources that I previously had so it was necessary to do it on the cheap.

I started researching the main board using various Internet forums and
reviews. I selected the main board and processor which appeared to do what I
wanted and purchased the whole collection of components at once. When I got
home, the first thing I discovered was a really messy CPU with white greasy
stuff all over the top of the chip and the bottom of the heat sink. I had zero
confidence in that working right so I took that one back and got another one.
With optimism and confidence in the outcome I assembled the entirety according
to directions, even getting additional instructions from the processor
manufacturer’s site on precautions.

Did it work? In a word, NO. The operating system could not be
installed. Must be a bad hard disk. Send that one back and get another
one. Did that one work. NO. Now try another main board. Did that work?
NO, just another clobbered hard disk. The power supply must be bad,
emitting bad voltages. Get a different case and power supply. Did that
work? NO. Get a friend to help. Did that work? NO.

What now? How do I figure out which component is bad? Let’s try the
Internet. I had done a bit of lurking on a couple of forums that had comments on
various computer problems from participants across the country, even out of the
country. So I lurked a bit more and picked the one that appeared to have the
group that was the most helpful and knowledgeable. I posted a one paragraph
description of my problem with description of the components and asked for
help.

About the time I signed off and went to check my email there was notice of
the first reply asking for more detail on the error messages that I had received. I
reran the attempt at installing the operating system and wrote down all the error
messages, typed them in a reply, and soon had three more comments, some
complete with links of diagnostic routines. To those more knowledgeable than I
the error messages apparently indicated a problem with the memory.

I ran the first referenced routine overnight (it ran for 12 hours and was still
not finished). After the tenth running hour I checked my mail again and used
another link which took me to a routine that was quicker and easier to
understand. I discontinued running the first which was indicating nothing but
errors and ran the second one which showed the memory stick failing all tests on
both passes.

That was enough evidence for me. Back to the store with what was
apparently either a faulty or mismatched memory strip. Fortunately they believed
me at the return area and were good enough to exchange for a different memory
strip. Considering the willingness, I don’t think I was the first with the problem,
but it was nice to get it done.

Oh yes, the system worked after I installed the new memory.
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by Billy Mabray
Oklahoma City PC Users Group, eMonitor — February 2004

Many people, including a lot of Web designers, think Web-site accessibility is
only about making sites work for blind users with screen reader software.
Accessibility should be about all of us. There is a wide range of physical
conditions that can make using the Web difficult. The Internet can be a
frustrating place when you have poor eyesight, colorblindness, or trouble using a
mouse. You may not fall into any of these categories right now, but consider this
statistic: 100% of Internet users are growing older. At some point, we will all
need help navigating the Web.

There are many things that can be done to make the Web more accessible.
Some of those things are already built into your Web browser. Others require
Web designers to implement accessible features on their Web sites. If you are
one of the many people who has difficulty using the Web, you will want to know
what help is out there.

One of the biggest complaints people have is that text is too small. It is also
the easiest to remedy. If you are using Internet Explorer, choose View>Text Size
from the top menu. Also, if your mouse has a scroll wheel, you can hold the
CTRL key and scroll up and down to change the text size. Now, this will not
work on all Web pages – later, we will discuss why that is and what Web
designers can do about it. The Netscape/Mozilla browser, however, can change
text size on all Web pages. Choose View>Increase Text Size, or hold CTRL and
press the + key.

There are many shortcut keys available for those who have difficulty
using a mouse. For example, the backspace key will take you to the previous
page, F5 will reload your current page, and ALT plus the Home key will take you
to your home page (the page set to load when you open your browser). Also, if
you have gone back to a previous page, ALT plus the right arrow will take you
forward again. Another useful key on any Web page is the TAB key. You can
use the TAB key (and SHIFT plus TAB to go in reverse) to quickly navigate
forward through all the links and form fields on a Web page. Once you have
tabbed to a form element, other keyboard shortcuts may come in handy. For
drop-down boxes, you can use the up and down arrows to highlight your
selection.  For radio buttons or checkboxes, use the space bar to select your
choice. If you are using a recent version of Netscape/Mozilla, you can also use
“Find As You Type.” Start typing at any page and it will automatically do a
search for what you are typing on that page.
Some people, particularly the colorblind, find Web sites hard to use because the
color of the text does not contrast enough with the background colors. If the
color scheme of your favorite Web site makes it difficult to read, you can
override that as well. You will find this under Tools>Options or Edit> Prefer-
ences, depending on your browser. You can set your default fonts, font
sizes, and page colors. You can also specify that your defaults always override
what is set by the Web page.

While these browser features can be helpful, there is still much Web
designers must do to make their site accessible to the widest possible audience.
A good example is text sizing. If Web designers use fixed text sizes — sizes that
specify an absolute unit of measurement, such as points or pixels — on their
pages, Internet Explorer users cannot change their text size as I described

earlier. Web designers can, and
should, use relative text sizes to make
their pages more accessible.
Designers who prefer to use absolute
sizes for text should provide a “style
switcher.” This is a link on the page
that allows the site’s visitor to make
the text bigger and saves that
preference in a cookie.

Another accessibility feature that
some designers use is access keys.
These are just like the shortcut keys I
mentioned earlier; except they are
defined by the Web page you are on.
For example, the designer could define
ALT plus 4 to take you directly to the
search function. If you visit a site
regularly and know their access keys,
they can be useful.

Web designers should also
use labels for forms. Labels
make the text next to a form
field clickable, just like the
field itself. For example, if a form
has a checkbox that reads, “Click here
to subscribe,” and that text is set as a
label, the user can click anywhere on
that text to check the box. It can be
very helpful to have a larger target
when trying to click things with a
mouse.

We still have a long way to go
before the Web is accessible to
everyone. But now you know some of
the helpful features you have at your
fingertips already, and you know what
to ask for from the Web sites you
frequent. Hopefully, as users learn
what they can do, and designers learn
what they need to do, we can all enjoy
the Web a little more.

 Billy Mabray and his wife, Angela,
own Smart Goat, a software develop-
ment and web design business. They
are members of OKCPCUG. Article
comments or questions are welcome.
Write: billy@smartgoat.com.

The Editorial Committee of the
Association of Personal Computer
User Groups (APCUG), an interna-
tional organization of which this group
is a member, brings this article to you.

CCESSIBILITY
for everyoneA
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PCI Express: Say goodbye
to AGP and PCI slots
by Timothy Everingham, TUGNET, teveringham@acm.org

Those of you who have been around personal computers for a
while might remember plug in cards slots referred to as ISA, EISA,
Microchannel, and VESA Local Bus. ISA, EISA, and Microchannel
were replaced by PCI. VESA Local bus was primarily for video
cards, which was replaced by PCI, then AGP slots. It was a fun
time during these card slot transitions because many times you
could not use the plug in cards from your old machine in your new
computer or motherboard or if you did it could slow down the entire
system. Well guess what, its time to do it all over again. Intel has
come up with a new slot standard PCI Express, which will
start to show up in computers/motherboards this spring.

PCI came out in 1992. Today these slots and its data bus
technology are used for things not envisioned when it was under
development over 12 years ago. PCI has its limitations and the PCI pro slots
never became popular. The limitations are coming to the forefront in delivering
multimedia content and Gigabit Ethernet. Of course getting higher frame rates
at higher resolution and quality for video games also is an issue. PCI has been
evolving over time increasing its speed to five times the original, but it has
reached its limits of development. Many say that stretching out the AGP to 8x
speed might be pushing at its limit too.

First let us look at the current PCI architecture you will find on most
motherboards. The CPU/Microprocessor communicates with the first of two
data bridges, normally referred to as the Memory Bridge or Northbridge. The
Northbridge not only communicates with the CPU; but also communicates to the
AGP port, which is where your main graphics card is (usually the only graphics
card). It also communicates with your RAM. The fourth thing it communicates
with is the second data bridge, known as the Input/Output (I/O) Bridge or
Southbridge. The Southbridge also communicates to your plug in slots/cards,
drive controllers, and USB, Fireware/1394, parallel. serial, game, keyboard and
mouse ports. The theoretical speed limit of the Southbridge communication to I/
O including the PCI slots is 133 MB/second. All of the communications in the
system are parallel with none of the data having any priority over any other.
Blocks of data have to be sent one at a time and cannot be done concurrently.
Therefore the data is transferred from one section of the motherboard to the
next section based on the order received, not the importance or whether a piece
of data arriving by a certain time to its destination is critical.

PCI Express, instead of using a parallel bus architecture, uses serial
networking typology with only two wires for each direction. At higher speeds, it
allows concurrent transfer of data while having a similar look and the same type
of Northbridge/Southbridge architecture as currently in desktops and laptops.

However, in servers the Southbridge is eliminated producing greater data
throughput. The PCI slots initially have a 250 MB/second throughput, but the
scalable width technology (increasing the number of wire pairs) enables slots
and cards to communicate at 32 times that speed in later implementations using
longer slots. But the typology can also use network switching type technology,
giving data priority and quality of service functions. Hot plug/swap of
components is a native part of the architecture.

The PCI Express Graphics Port, replacing the AGP Port, will have a
4GB/second transfer rate in its initial configuration, double that of the

current 8x AGP ports. For laptops
units there will be a new plug-in
card to replace PCMCIA called
ExpressCard. It will come in two
forms, one that more looks like a
PCMCIA card referred to at the 34
module form factor (34 x 75 x 5 mm)
and a more oversized L looking card
called the 54 module form factor (54 x
75 x 5 mm). This new architecture is
compatible with existing operating
systems.

Also the new PCI Express slot
is capable of being placed
alongside current type PCI slots
so a choice can be made which
type of card can be used in a
motherboard just like was done
with ISA slots and current PCI
slots. The standard PCI Express
slots being put in motherboards
this spring (1x) will be a lot
shorter than the standard PCI
slots.

All of this will mean that a lot of
issues having to do with multimedia on
desktop and laptop computers will
have been solved. It also opens wider
use of Gigabit Ethernet on local area
networks. It also enables the
prospects of new motherboard form
factors and computer case designs.
As the transition from ISA to PCI was

AGP slot

PCI slots

(Continued to page 10)
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go to properties. Click on the radio
button next to Start Menu and click on
the Customize... button. Then, click on
the Advanced tab. Locate the Run box
and check the box on the left. Then,
click on clear history.

2. You can navigate to
HKEY_CURRENT_ USER\
Software\Microsoft\Windows\
CurrentVersion\Explorer\ RunMRU.

This is where you will find all the
commands in the Run history. Delete
the ones you don’t want. But, backup
the registry first!

Run…
(Continued from page 4)

an interesting transition with computer
buyers having to do more research
and planning on their purchases, the
move from PCI to PCI Express will
do the same. However, as was with
the previous transition, the perform-
ance and capability increases of
computers will be profound. Further
information on PCI Express can be
found at www.express-lane.org.

Timothy Everingham, CEO of
Timothy Everingham Consulting in
Azusa, California, is  also Vice Chair of
the Los Angeles Chapter of ACM
SIGGRAPH; a member of  the Manage-
ment Information Systems Program
Advisory Board of California State
University, Fullerton; Vice President of
the Windows Media Users’ Group of
Los Angeles; part-time writer of  high
technology, computers, video, audio,
and entertainment/media;  and has
been published throughout the United
States, Canada,  Australia, England,
and Japan. See more at http://home.
earthlink.net/~teveringham.

There is no restriction against any
non-profit group using this article as
long as it is kept in context with proper
credit given the author. The Editorial
Committee of the Association of Pers-
onal Computer User Groups (APCUG),
an international organization of which
this group is a member, brings this
article to you.

PCI Express…
(Continued from page 9)

Notepad… (Continued from page 2)

by Linda Gonse

Like many other computer users, I subscribed to Windows magazine until its
sad demise. One of the columns I had enjoyed was written by Mike Elgan, the
editor of Windows magazine. Recently, from a link on Fred Langa’s site (another
Windows magazine survivor) I found that Mike Elgan is still around and is active
on the Internet.

His website, www.mikeslist.com/, and free newsletter offer up-to-date
computer news and yet give equal time to the humorous and wacky side of
technology. Subjects he tackles include technology culture, smart phones, smart
people, random gadgets, bad ideas, weird computers, painful implants, malicious
robots and the Internet.

Sign up for Mike’s newsletter or tune in
to Craig Crossman’s Computer America
(www.computeramerica.com) featuring
Mike Elgan Thursday nights. The show
runs from 7 pm to 9 pm and is on the
local Business TalkRadio station or on the Internet every week night.

AOL disapproves of.
I can verify this through firsthand experience. Undeliverable email and error

messages informed me that AOL identifies the server that ORCOPUG resides
on as a spammer. Therefore AOL rejects all email from orcopug.org, in addi-
tion to email sent from comcast.net that contained a link to our newsletter! (In
fact 88% of ALL newsletters going to AOL — including those on subscribers’
white lists — are rejected! See http://briansbuzz .com/w/040408/)

Here’s a final item. You may one day encounter spyware, adware, or a
Trojan that takes control of your browser and causes a blizzard of pop-up
windows—pointing to a porn or sales site. “Browser hijacking” may also
prevent working on your computer until you find and remove the hijacking
program. Before you get hijacked, head over to http://www.rediff.com/
netguide/2003/jul/15hijack.htm and read how to prevent it.

Although your experience might be different from mine, here is the
removal plan that worked for me that you might try. Go to Safe Mode. Open
browser (I had IE). Go to Tools and Internet Options. Click Use Blank for start
page and delete Temporary Internet files, click  Apply, and OK. Then, go to
Run and type in msconfig. Click OK. Select Startup tab and remove checks
in boxes next to suspect programs. (Don’t uncheck systray.) Go to Add/
Remove Programs and look for new and unusual entries to delete. I also ran
Search for Files and Folders to find new files and deleted the baddies still on
my computer. Then, I ran both SpyBot–Search & Destroy and Ad-Aware, and
deleted the entries they found. Lastly, I downloaded Google’s free toolbar and
enable its pop-up window stopper when I surf the ‘net.

Linda Gonse,
editor@orcopug.org

Whatever happened to…Mike Elgan?

mailto:editor@orcopug.org
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Peripherals

Newsletter deadline
May 22

Internet Humor

Excerpt from SANS NewsBites, a free online
newsletter available at www.sans.org

Earthlink audit service finds spyware items on PCs

Data collected by Earthlink through its free SpyAudit service found
an average of 28 spyware items on PCs scanned during a three month
period. http://news.zdnet.co.uk/internet/security/
0,39020375,39152266,00.htm, http://www.theregister.co.uk/2004/
04/16/spyware_audit/

[SANS editor’s note: Hooray for Earthlink! The individual is given a
choice whether to scan their machine, and, from the posted results,
every user needs to do the scan. Possibly the GUI and advertisement
for this service is not quite what your mom and dad need, but it is close,
and if you were to call and talk your mom or dad through it they would
be fine. http://www.earthlink.net/spyaudit/]

Program will warn users of suspected phishing sites

Earthlink plans to release a program that will warn users if they click
on an e-mail link that directs them to a website that has been reported
as a phony. The ScamBlocker program will be available to everyone,
not just Earthlink customers. http://msnbc.msn.com/id/4741973

Spammers sending fake stock tips

The incidence of phony stock-tip related spam has grown three fold
between December 2003 and March 2004. http://www.reuters.com/
newsArticle.jhtml?type=internetNews&storyID=4865047&section=news

ore single women are
buying homes and a  major
toolmaker is hoping to tap

the new market…

Submitted by Loren Tuthill

GCPCUG plans unique
first event

by Ed Van Meter, Region 11 Advisor

On the weekend of July 30, 2004,
Greater Cleveland PC Users Group
(GCPCUG) will be holding an
Association of PC User Groups
(APCUG) Regional Event in
coordination with the International
Children’s Games Competition — to
be held in the United States for the
first time and in Cleveland, Ohio!

For more information visit their
web page at www.chriskingworking
.com/regionalgames.htm

Members get new special
offers and discounts!

by Linda Gonse

Go to the Members’ Only! page on
our website to see the new offers for
MediaResizer, GhostSurf Pro, and
MailWasher Pro.

Only members in good standing are
allowed to access the password-
protected pages with fantastic offers,
just for them. Our website is at
www.orcopug.org.

Things life has taught me

“Some Days You’re the Pigeon, Some
Days You’re the Statue” — Becky
Dietrich.

“I Childproofed My House, But They
Still Get In!”— Angee

Computer users BEWARE!

Newsletter contributors

Billy Mabray, Carl Westberg,
Charlie Moore, Dick Tooley, Donald
Gonse, Ed Van Meter, Herb
Goodman,  Judy Taylour, Linda
Gonse, Marsee Henon, Mike
Lyons, Patricia Hill, Richard Tooley,
Terry Currier, Tim O’Reilly, Timothy
Everingham, Tony Lake
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Orange County
IBM PC Users’ Group

P.O. Box 716, Brea, CA 92822-0716

Reprint Policy: Permission is given to user groups  to reprint  unaltered, uncopyrighted material, with credit to the author and Nibbles & Bits.

Planning meetings are held the third Thursday of every month  at 7 p.m. at
Downey Savings & Loan, one block east of Harbor at Bastanchury in Fullerton. All
members are invited to attend the planning meetings! 

The Orange County IBM PC Users’ Group regular meeting is scheduled for the
second Tuesday of the month at 6:30 p.m. at the Sunny Hills Racquet Club, 1900
Camino Loma, Fullerton, (714) 992-1300.

For more information, call (714) 990-0580, or go to www.orcopug.org.

Directions: From the 91
Freeway, exit at Euclid
and go north. Go past
Bastanchury and turn
west (left) onto Rose-
crans. Sunny Hills
Racquet Club is located
on the south (left) side
of  the street.

The Public Is Welcome! Meetings Are FREE!

New Programs

Tuesday, May 11

6:30 p.m.

UG Member Benefits

• Product & “How To”demos
• Free raffles and magazines
• Help from other members
• Newsletter and web site
• Special offers & discounts
• Monthly meetings
• Affiliation with worldwide group

A user group membership is the best
accessory you can buy for your
computer.  — Ash Nallawalla,
Melbourne PC Users’ Group

Check out our
award-winning web site!

Online Review Form!
Virus/Hoax Lookup!
PDF Searches!
Personalized Map!

NOW
IT

HAS

Send a printed copy of the newsletter to a friend. Use this mailing sheet for the address. Staple newsletter together
at top left corner with this last page facing out. Fold in half, so this page is visible. Tape ends together, stamp and mail.

www.orcopug.org

http://www.orcopug.org

